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Chapter 1
Introduction
Thank you for choosing the DynaComm Connectivity 
Series 9—the most powerful terminal emulation product 
available for Windows. FutureSoft maintains an excel-
lent source of easily accessible information on the World 
Wide Web. Find answers to your questions, check out new 
product information, view demonstrations of FutureSoft 
products, and more at www.futuresoft.com 

This manual:

• Introduces you to the features and capabilities of the 
DynaComm Connectivity Series in chapter 1.

• Guides you through installation of a single user copy 
of the software in chapter 2.

• Demonstrates how to use the basic functions through 
a tutorial in chapter 3.

• Reviews all removal procedures in chapter 4.
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• Euro symbol support

Input or display the euro character representing Euro-
pean Union common currency.

• Menu Editor

Use the menu editor to customize application-level 
menus to send a string, launch an application or 
script.

• OLE-compliant text editor

An OLE-compliant text editor is included in the base 
product. Embed documents from other applications 
into a memo document.

• Powerful event-driven scripting language

An integrated, full-featured script language with over 
350 commands and functions that include condition-
al execution, subroutine execution, event handling, 
and the creation of custom menus and dialog boxes.

• Toolbar editor

Customize application toolbar to create custom 
toolbar buttons to send a string, launch an application 
or script, or perform a menu command.

• Y2K Compliant

DCS 9 contains no date calculation functions. The 
only use of dates is through scripting functions that 
make a call to the Windows operating system and use 
the date provided by this system. Windows dates are 
based on a four-character year and, therefore, are not 
affected by the change of the century.

• WinHLLAPI and EHLLAPI support (TN3270 and 
TN5250 Client Options only)

DCS 9 includes both 32-bit EHLLAPI and 32-bit 
WinHLLAPI dynamic link libraries to support 
Microsoft® Windows® applications requiring HLLAPI 
interfaces. Custom applications can call these libraries 
directly to interact with TN3270 and TN5250 ses-
sions.

DCS 9 Features

Standard features in DCS 9 include:

• Full suite of standard emulations

Base product emulations include:

ADDS VP/60
AT&T 605/705 
ANSI-BBS (with SCO ANSI extensions)
Digital VT Series (52/100/102/220/320/420)
TeleVideo 925/950
Wyse 50/60

Additional add-on emulations: 

AT&T 4425 TN3270 TN5250
HP 700/94 Tandem 6530

• A range of standard connectivity options

Base product connectors include:

Direct Serial
Meridian LAT32
Modem (TAPI)
Telnet (TCP/IP and IPX/SPX)
SSH 1
SSH 2

Additional connector: 

Microsoft SNA Server (with TN3270 Client 
Option)

• Full suite of standard file transfer protocols

Base product file transfer protocols include:

Kermit FTP
XYModem ZModem

Additional file transfer protocols:

IND$FILE (with TN3270 Client Option)
IXF (with Tandem 6530 Client Option)

• Drag-and-drop file handling

Load a session, memo, or script by dragging corre-
sponding icon into the DCS application window.
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Client Option Packages

To expand the functionality of DCS 9 to meet specific 
enterprise requirements, Client Option packages for specific 
host environments are available. These are add-on emula-
tion products that require installation of the base product 
before installation of the individual client option. Purchas-
ing an individual emulator allows for supporting a unique 
computing environment and eliminates the expense of 
unnecessary emulations.

Each Client Option presents the same graphical interface 
as the base product to provide for a consistent computing 
environment. It also supports multiple emulation sessions 
from within a single instance of the application just as the 
base product allows.

AT&T 4425 Client Option

6 Supported Emulations

• AT&T 4425

• Equivalent AT&T 6539 functionality

6 Network Connectivity

The AT&T 4425 Client Option supports the follow-
ing connectors included in the base product:

• Direct Serial

• Modem (TAPI)

• Telnet (TCP/IP and IPX/SPX)

6 File Transfer Protocols

The AT&T 4425 Client Option supports the fol-
lowing file transfer protocols included in the base 
product:

• FTP

• Kermit

• XModem 

• YModem 

• ZModem
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HP 700/94 Client Option

6 Supported Emulations

• HP 700/92

• HP 700/94

6 Product Highlights

• Hotspot support

• Support for downloadable characters and soft 
fonts

• On screen function keys

6 Network Connectivity

The HP 700/94 Client Option supports the follow-
ing connectors included in the base product:

• Direct Serial

• Modem (TAPI)

• Telnet (TCP/IP and IPX/SPX)

6 File Transfer Protocols

The HP 700/94 Client Option supports the following 
file transfer protocols included in the base product:

• FTP

• Kermit

• XModem 

• YModem 

• ZModem

Tandem 6530 Client Option

6 Supported Emulation

• Tandem 6530

6 Product Highlights

• EM3270 support

• Block mode type ahead

• Hotspot support

6 Network Connectivity

The Tandem 6530 Client Option supports the fol-
lowing connectors included in the base product:

• Direct Serial

• Modem (TAPI)

• Telnet (TCP/IP and IPX/SPX)

6 File Transfer Protocols

The Tandem 6530 Client Option supports the fol-
lowing file transfer protocols:

• IXF
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TN3270 Client Option

6 Supported Emulations

• 3278 Models 2 – 5

• 3279 Models 2 – 5 (with and without extended 
attributes)

• 3287 Telnet printing support

• TN3270E with print

6 Product Highlights

• EHLLAPI
(32 bit dynamic link libraries to support 
Microsoft)

• WinHLLAPI
(Windows applications requiring HLLAPI 
interfaces)

• Hotspot support 

• LU1/LU3 print 

6 Network Connectivity

The TN3270 Client Option supports the following 
connectors:

• Microsoft SNA Server with print support

• Telnet

6 File Transfer Protocols

The TN3270 Client Option supports the following 
file transfer protocols:

• IND$FILE (supports TSO, CICS and CMS)

TN5250 Client Option

6 Supported Emulations

• 5250 Models 2 – 5

• 3812 Telnet printing

• TN5250E with print

6 Product Highlights

• EHLLAPI
(32 bit dynamic link libraries to support 
Microsoft)

• WinHLLAPI
(Windows applications requiring HLLAPI 
interfaces)

• Hotspot support 

6 Network Connectivity

The TN5250 Client Option supports the following 
connectors:

• Telnet

6 File Transfer Protocols

The TN5250 Client Option supports the following 
file transfer protocols:

• FTP 
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New In DCS 9

6 Certification for Windows Vista™

DCS 9 is certified as an application for the Windows 
Vista operating system. 

6 SSH 1 & SSH 2 connectivity support

SSH 1 & SSH 2 connectors are now available 
through the New Session wizard or the Session Prop-
erties dialog.

6 New file version numbers

In this release DCS 9 and all add-on Client Option 
files have a product version of 9.0.0.0.

6 Documentation Library Update

The DCS 9 documentation library consists of:

• Getting Started with DCS 9 for Users

(eBook)

Designed for the user; includes features overview, 
installation and configuration procedures and a 
tutorial covering the major DCS 9 functions.

• Getting Started with DCS 9 for Administrators 

(eBook)

Designed for the System Administrator; focuses 
on the use of Web Install and DynaComm Multi-
user Administrator functions.

• Script Language Reference*

(eBook)

Technical information for all commands and 
functions used in the DCS Scripting Language.

• Release Notes* (readme.doc)

Includes last minute information not included in 
the documentation as well as important items of 
particular significance.

• DCS 9 Online Reference*

(Help system)

Technical information for DCS 9 features and 
functions and all Client Options.

• FSFTP Online Reference*

(Help system)

Technical information for the FutureSoft 32-bit 
File Transfer Protocol utility.

• HLLAPI Auto-Launch Configuration Online Refer-

ence* (Help system)

Technical information for using HLLAPI calls 
with third-party applications.

• Visual Basic Client Online Reference*

(Help system)

Technical information for Visual Basic Interface 
functions.

• Script Language Online Reference*

(Help system)

Technical information for all commands and 
functions used in the DCS Scripting Language.

• DCS 9 Administrator Online Reference*

(Help system)

Technical information for installation and 
maintenance of DCS 9; includes DynaComm 
Multi-user Administrator information.

• Product Registration & Technical Support Card 

(print)

Used to register the DCS 9 product; provides 
FutureSoft contact information.

* These items are provided on the installation CD-
ROM in the /documentation folder. The most current 
versions of electronic documentation can be down-
loaded from www.futuresoft.com/documentation.
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Upgrading to DCS 9

All DCS 7.1.0.4 (and earlier) installations must be removed 
before installing DCS 9. Do not install DCS 9 over an older 
installation of the DynaComm Connectivity Series.

Do not mix install types. For example, if DCS 9 is installed 
with the Standard Install method, do not use Web Install to 
install Client Options - use the Standard Install method to 
install Client Options.

Getting Help

When you need help with DCS 9, use one of the following:

6 Release Notes (readme.doc)

Review the readme.doc file before using DCS 9. This 
document provides last-minute information.

To open the readme.doc file

1 On the Start menu, select Programs and then 
click DynaComm Connectivity Series 9.

2 On the DCS 9 menu, click Read Me.

6 Electronic Help

• Online References

The Online References contain the most current 
and complete information about DCS 9 func-
tions and utilities. 

To use an Online Reference

1 On the Help menu, select Contents to 
display the Master Help Explorer window.

2 In the Explorer pane of the Help window, 
select an online reference to view in the 
Contents pane.

To use Context-Sensitive Help

• With a dialog or screen on display, press 
the F1 key or click the Help button in the 
dialog.

To use Script Help

1 Open a script file with the DCS 9 Script 
Editor.

2 Enter the full name of a command or func-
tion. 

Do not select any keywords or other 
parameters.

3 Highlight the command or function and 
press F1.
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• eBooks

eBooks are in Adobe Acrobat PDF format and 
require the Acrobat Reader for display.  To down-
load the Acrobat Reader, visit www.adobe.com.

– To open, double-click the PDF file name.

6 Help on Help

If you’re not familiar with the Windows online Help 
system and functions, select Help from the Help 

menu. This opens the Windows Help file that de-
scribes how to use a standard Windows Help system.

6 Documentation Questions or Comments

If you have any questions or comments about DCS 
9 documentation, we would like to hear from you. 
Please contact us via e-mail at docs@futuresoft.com.

Product Support

If you don’t find the answer in the documentation to 
your question or problem, registered users of DCS may 
call FutureSoft Technical Support for assistance. Standard 
telephone support is available weekdays, 8 a.m. to 5 p.m., 
Central Standard Time (CST).

Before contacting Technical Support, gather details about 
your question which should include all hardware and 
software configurations, the DynaComm version number 
(found through the About DynaComm option on the Help 

menu), any other software loaded (including TSRs) when 
you experienced the problem, and the exact sequence of 
steps that preceded the problem.

 Phone Number Fax Number

US 281.588.6868 US 281.496.1090

UK +44 (0) 1260 292219 UK +44 (0) 1260 292224

 E-mail

 UK support@futuresoft.com

 US support@futuresoftuk.com

Visit the FutureSoft web site for more information at 
www.futuresoft.com
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Chapter 2
Installation
Before You Begin

This section details activities to complete before, during 
and after installation. Read through all information in this 
section and complete the following activities.

6 Check system requirements

The minimum requirements for operating DCS 9 on 
a personal computer are:

• Software

Windows 95/98
Windows NT 4.0
Windows NT, Terminal Server Edition
Windows 2000
Windows XP
Windows 2003 Server
Windows Vista

• Hardware

486 processor
10MB hard drive space for a complete installation
CD-ROM drive
At least one of the following:

• For direct connections, one free serial port
• For phone line connections, a modem
• For network connectivity, a network inter-

face card

6 Remove previous versions of DCS

To upgrade from version 7.0 (or earlier) of DCS, 
remove any prior version before installing DCS 9. If 
you are not sure which version of DCS is installed, 

select About DynaComm from the Help menu to 
display product version information.

Files created after DCS 7.0 is installed, such as session 
files and scripts, are not removed during the uninstall 
process. These files can be stored elsewhere during the 
installation procedure.

6 Backup the installation media

You are licensed to create up to three backup copies of 
DCS 9 installation media. Create at least one backup 
copy and use it for installation.

6 Locate the product serial number

During the installation process, you will be required 
to enter a valid product serial number. The serial 
number is located on the installation media and your 
product registration card.

6 Register DCS 9 

Send in the enclosed postage-paid registration card by 
mail or fax.

12012 Wickchester
Suite 600
Houston, TX 77079
Fax: 281.496.1090

6 Close applications

Before starting the installation program, quit any 
running applications to ensure a smoother installation 
process.
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Working with the Setup Program

The Setup Program guides you through the installation of 
DCS 9. Setup uses two basic functions: Starting and Exit-
ing.

Before starting the Setup Program, be sure that you have 
reviewed all the material in the Single User section in this 
chapter. That section provides background information for 
the responses required for the Setup Program.

Working with the Setup Program includes:

Step 1: Start the Setup program.

More than one method can be used to start the 
Setup Program.

Step 2: Respond to Setup screens to install appropriate 
components.

The Setup Program presents a series of screens that require a 
response for each. Details for each screen are provided in the 
following chapters.

Starting Setup

The Setup Program is started through the:

6 FutureSoft Connectivity Products menu

6 Windows Run dialog

6 Add/Remove Programs selection in Windows Control 

Panel.

CD Autorun

If CD Autorun is enabled on the install machine, the 
FutureSoft Connectivity Products menu appears when you 
insert the installation CD-ROM in the appropriate drive.

In addition to installing the software, the FutureSoft Con-

nectivity Products menu offers other choices for viewing 
documentation or other items on the CD-ROM.

Windows Run Dialog

If CD Autorun is disabled, the Setup program can be 
started from the Windows Run dialog.

6 To start the Setup Program from the Windows Run 

dialog:

1 Place the installation CD-ROM in the appropri-
ate drive.

2 On the Windows taskbar, click Start and then 
select Run.

3 In the Run dialog, enter the CD-ROM drive 
name followed with “setup.exe”.

4 Click OK.

Windows Control Panel

The Setup Program can also be started from the Add/

Remove Programs selection in the Control Panel window.

6 To start the Setup Program from the Windows Control 
Panel:

1 On the Windows taskbar, click Start.

2 Highlight Settings and select Control Panel.

3 Double-click Add/Remove Programs.

4 In the Add/Remove Programs Properties dialog, 
click Install.

5 Place the installation CD-ROM in the appropri-
ate drive.

6 In the Run Installation Program dialog, click 
Next.
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Welcome Dialog

The InstallShield Wizard dialog appears to indicate the sta-
tus of the installation program load. When Setup initializa-
tion is complete the Welcome screen appears. Setup is ready 
to begin installation of DCS 9.

Exiting Setup

During the installation process, if you click Cancel on any 
screen, the Exit Setup dialog appears.

6 To respond to this screen, click either:

• Yes to stop the installation and exit the Setup 
Program.

• No to return to the previous screen and continue 
with Setup.

Single-User Installation

After completing pre-installation activities, follow the steps 
below to set up an individual copy of DCS 9. These steps 
use the standard install method for installing from a CD-
ROM. 

Some steps may ask to enter information or to make a 
choice. Read the descriptions carefully before completing 
the step. Most steps do allow you to return to the previous 
screen to make changes, if necessary. However, copying of 
DCS 9 files begins when you click Next on the Select Us-

age screen. To make corrections at this point, you will need 
to remove DCS 9 and reinstall.

Step 1:  Start the Setup Program

Start the installation program using one of the techniques 
discussed in Chapter 2 Setup Program.

Step 2:  Respond to Setup dialogs

Setup Dialog 1:  Welcome

The Welcome message indicates that the Setup program 
is now ready to begin installation of DCS 9 and reminds 
you to quit any running applications. It also includes the 
copyright warning.

To respond to this dialog

6 Choose one of the following:

• Next to continue with the installation.

• Cancel to exit Setup.
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Setup Dialog 2:  Software License Agreement

Installation and use of DCS 9 is governed by the terms of 
the online license agreement. Make sure you read and agree 
to the terms of the agreement before installing DCS 9.

If you have any questions about the terms of the online 
license agreement, please contact your FutureSoft account 
manager or send e-mail to info@futuresoft.com.

To respond to this dialog

1 Choose to accept/not accept the license agreement 
terms.

2 Choose one of the following:

• Back to return to the Welcome dialog.

• Next to continue with the installation.

• Cancel to exit Setup.

Setup Dialog 3:  Customer Information

The Customer information identifies you to DCS 9. You 
must complete both entries to continue the installation.

To respond to this dialog

1 Enter the following:

• Your full name in User Name.

• Your company name in Organization.

2 Choose one of the following:

• Back to return to the Software License Agree-

ment dialog.

• Next to continue with the installation, or

• Cancel to exit Setup.

Setup Dialog 4:  Select Setup Type

Four options are presented for installing components and 
sub-components of DCS 9:

6 Complete

6 Custom

See the first page of this chapter for a description of each 
option.

To respond to this dialog

1 Select one setup option.

2 Choose one of the following:

• Back to return to the Choose Destination Loca-

tion dialog.

• Next to continue with the installation.

• Cancel to exit Setup.
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Optional Setup Dialog:  Custom Setup

When the Custom setup type is chosen, the next dialog 
shown is Custom Setup.

All components of the base product and all Client Options 
are shown. Each component displays the local hard drive 
icon which means that it will be installed on the local hard 
drive. To change how, or if, the component is installed, click 
on the down arrow on the hard drive icon and select from 
one of the available options.

Selecting a component hard drive icon displays space 
requirements for the selected component in the Feature 
Description group. To see space requirements for all se-
lected components, click Space to display the Disk Space 

Requirements dialog. This dialog lists the available space 
on the selected drive and the space requirements for the se-
lected DCS components. Highlighted volumes indicate that 
space requirements for DCS are greater than the available 
space. Click OK to return to the Custom Setup dialog.

On the Custom Setup dialog, Install to displays the loca-
tion where DCS files will be installed. The default location 
is the C:\Program Files\FutureSoft\DCSeries folder. Use 
Change... to modify this location, if needed.

To respond to this dialog

1 Change components and sub-components as needed.

2 Choose one of the following

• Back to return to the Select Setup Type dialog.

• Next to continue with the installation.

• Cancel to exit Setup.

Setup Dialog 5:  Ready to Install the Program

The Ready to Install the Program dialog allows you 
to return to previous screens to make any last minute 
changes.

To respond to this dialog

6 Choose one of the following

• Back to return to the Select Setup Type 
dialog.

• Install to continue with the installation.

• Cancel to exit Setup.

Setup Dialog :  InstallShield Wizard Completed

The InstallShield Wizard Completed dialog is the last 
dialog displayed in the installation of DCS 9. Two op-
tions are provided:

To respond to this dialog

6 Click Finish to complete the installation.

Installation of DCS 9 is complete.
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Licensing DCS 9 and Client Options

If you installed an evaluation version of DCS 9 or would 
like to activate a Client Option, the Licenser utility applies 
the valid serial number that you received when the product 
was purchased. The Licenser utility is started from the 
DynaComm Connectivity Series 9 program group. 

To apply a valid serial number

1 On the Windows taskbar, click Start and highlight 
Programs.

2 Highlight DynaComm Connectivity Series 9 and 
click Licenser.

The FutureSoft Licenser dialog appears.

3 Enter the serial number in the provided box and click 
License.

The DynaComm Connectivity Series dialog appears.

4 In the User Information group, do the following:

a In User name, enter a complete user name.

b In Organization, enter a complete organization or  
group name.

5 Click OK.

A confirmation dialog appears.

6 Click OK.

A question dialog appears.

7 Do one of the following:

• Click No to end the licensing function.

• Click Yes to repeat steps 3 through 6.

Optionally, the Licenser utility can be run from a command 
line or in a batch file. The command takes the form of:

licenser /L ######################### 

where “#” represents the base product or Client Option 
serial number.

Note:  Licensing on Windows Vista systems requires Ad-
ministrator access rights.

Installation Troubleshooting

If you encounter an error while installing DCS 9, one of 
the following common installation problems may have oc-
curred:

• General file transfer error

The Setup program was unable to copy the files to 
your destination directory. Make sure you have per-
mission to write to or modify the specified destination 
directory.

• Error reading disk drive

Make sure the CD drive is in proper working order. 
Try reading another CD in the same drive.

Make sure you have inserted the installation CD cor-
rectly in the disk drive – the label should be face up.

If the drive is functioning and the media is properly 
inserted, the disk may be defective. If you are install-
ing from a backup copy, install from the original 
media instead. If you are installing from the original 
media, please contact your FutureSoft Account Man-
ager for a replacement.

• Installation has detected a previous version of the 
DynaComm Connectivity Series

DCS 9 cannot be installed over a previous version 
of DCS. You must remove the previous version first, 
then install DCS 9.
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This chapter presents the five basic functions of DCS 9 in 
a tutorial. Begin with the first topic, Getting Started, and 
work through each topic in the order presented. Each topic 
builds on the information presented in the previous topic(s) 
and assumes you have completed all prior topic(s).

The topics are arranged to give you a progressive overview 
of the most commonly used functions. The topics covered 
in this tutorial are:

6 Lesson 1:  Getting Started

Reviews methods for starting the DCS 9 application.

6 Lesson 2:  DCS 9 Files & Folders

Describes files and folder structure used by DCS 9.

Chapter 3
Tutorial

6 Lesson 3:  DCS 9 Window

Describes the DCS 9 application window compo-
nents.

6 Lesson 4:  Working with a Terminal Session

Reviews procedures for creating, saving and opening 
terminal sessions.

6 Lesson 5:  Transferring Files

Discusses the process and procedures for moving files 
to and from a host to a local terminal.

6 Lesson 6:  Printing

Reviews all print commands and options.
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Lesson 1:  Getting Started

This first lesson:

6 Describes the DCS 9 program group.

6 Presents methods for starting DCS 9.

6 Lists steps to open DCS files. 

DynaComm Connectivity Series 9 Program 
Group

The DynaComm Connectivity Series 9 program group is 
created during the installation process. It is added to the 
Programs section of the Windows Start menu.

Starting DCS 9

6 To start DCS 9 from an icon

• On the Windows desktop, double-click the icon 
associated with DCS 9.

6 To start DCS 9 from the Start menu

1 On the Windows taskbar, click Start and high-
light Programs.

2 On the Programs submenu, highlight 
DynaComm Connectivity Series 9 and click 
DynaComm Connectivity Series 9.

6 To start DCS 9 from a browser window

1 Start the Internet browser.

2 In Address, enter the full path of the DCS 9 ap-
plication file location press Enter.

6 To start DCS 9 from a command line

1 On the Windows taskbar, click Start and select 
Run.

2 In the Run dialog, enter dcseries and click OK.

Figure 3.1

DynaComm Connectivity Series 9 Program Group.

DCS 9 Administrator Online Reference (Help system)

DCS 9 Online Reference (Help system)

DCS 9 application

File Transfer Protocol utility

File Transfer Protocol Online Reference (Help system)

Link to home page on FutureSoft web site

Authorized DCS 9 Licenser utility

Link to online registration page on FutureSoft web site

Readme file with release notes for current release

Script Language Online Reference

Visual Basic Interface Online Reference
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Lesson 2:  DCS 9 Files and Folders

This second lesson:

6 Presents all installed DCS 9 folders and describes the 
files stored in each.

6 Lists each file type and the file name extension.

Folders

When DCS 9 is installed, several folders are created to hold 
files used by the program. Figure 3.2 lists all folders created 
in a DCS 9 installation with a description of the files stored 
in each. Note that VBClient has several subfolders.

Figure 3.2

DynaComm Connectivity Series 9 folders and files.

conn connector (*.flx) files

display display (*.flx) files

dnload downloaded files (default target folder)

emul emulation (*.flx) files

fonts font files used by DCS

ft file transfer (*.flx) files

maps attribute (*.acm) and keyboard (*.kbd) files

memos memo (*.dcm) files (default target folder)

scripts script (*.dcp & *.dct) files (default target folder)

session session (*.ses) files (default target folder)

trace trace (*.trc) files (default target folder)

upload files to upload (default target folder)

vbclient Visual Basic Interface files (default target folder)

   samples  

asp sample Active Server Page (*.asp) files

vb sample Visual Basic (*.vbp, *.vbw & *.frm) files
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The default location for install folders is:

c:\Program Files\FutureSoft\DCSeries

Depending on the operating system, selected folders are also 
created in a second location:

6 Windows NT

6 Windows 2000 Professional
Windows 2000 Server
Windows XP
Windows 2003 Server

WINNT

Profiles

username

Personal

Documents and Settings

username

Personal

All folders, except VBClient, can be moved and redirected 
through the File Locations tab of the Options dialog. How-
ever, we recommend that “default” folders remain in their 
original install location to ensure function integrity.

Figure 3.3

File Locations tab of Options 

dialog.
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Files and File Types

When DCS 9 is installed, eight (8) file types are placed 
in the install folders. Each file type has a specific function 
within DCS 9.

6 Document files are opened and edited in DCS 9. 
ese files can be associated with an icon placed on 
the desktop. Double-clicking on the file name or the 
associated icon starts DCS 9 and opens the file.

FutureSoft File Type File Extension

Script file (compiled script) *.dct

6 When a script document (.dcp) is compiled, a com-
piled script file (.dct) is created. ese files are run or 
executed inside DCS 9 and can be associated with an 
icon. Double-clicking the file name or associated icon 
starts DCS 9 and runs the script.

6 Program support files have extensions of .acm, .kbm 
and .trc. ese files are loaded by DCS 9 when a ses-
sion file is opened. ese files are not opened directly 
in DCS 9 or in any other application.

FutureSoft File Type File Extension

Memo document *.dcm

Script document *.dcp

Session document *.ses

FutureSoft File Type File Extension

Emulation object file *.flx

Connector object file *.flx

File Transfer object file *.flx

FutureSoft File Type File Extension

Attribute Map file *.acm

Keyboard Map file *.kbm

Trace Facility file *.trc

6 Session properties for emulations, connectors and file 
transfer protocols are stored in application files with 
an extension of .flx. ese files are used by DCS 9 and 
are are not opened directly.
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Opening Files

6 To open a session file (*.ses), script document (*.dcp) 
or memo document (*.mem) from the desktop

• Double-click an icon associated with the cor-
responding file or document.

6 To open a session file, script document or memo 
document from a command line

1 On the Windows taskbar, click Start and select 
Run.

2 In the Run dialog, enter “filename.ext “and click 
OK.

Where:

filename is a fully qualified path and name of 
the session file, script document or memo 
document to open when DCS 9 starts. 

 .ext is the corresponding file extension.

Note:  e opening and closing quotation marks 
must be included.

6 To open a session file in DCS 9

1 On the File menu, highlight Open and click Ses-

sion.

2 In the Open dialog, select a session file and click 
Open.

6 To open a script document in DCS 9

1 On the File menu, highlight Open and click 
Script.

2 In the Open dialog, select a script document and 
click Open.

6 To open a memo document in DCS 9

1 On the File menu, highlight Open and click 
Memo.

2 In the Open dialog, select a memo document and 
click Open.

Starting a Script

6 To start a compiled script (*.dct) from the desktop

• Double-click an icon associated with a compiled 
script file.

6 To start a compiled script (*.dct) file from a command 
line

1 On the Windows taskbar, click Start and select 
Run.

2 In the Run dialog, enter “script.dct “and click OK.

Where:

script is a fully qualified path and name of the  
script file to execute when DCS 9 starts. 

Note:  e opening and closing quotation marks 
must be included.

Tip:  Use Browse to select the file to open.

6 To start a compiled script (*.dct) file in DCS 9

1 On the Script menu, click Run.

2 In the Select a script file to execute dialog, select 
a compiled script file and click Open.
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Lesson 3:  DCS 9 Window

This third lesson

6 Reviews major elements of the DCS 9 window. 

6 Describes all toolbar buttons

Menu bar

Displays names of menus 
that list commands 
grouped by function.

Toolbar

Click to access 
frequently used 
commands.

Window Controls

Click to modify window 
dimensions.

Messages

Displays messages 
about DCS 9 or 
the session.

Status Indicators

Displays current 
system conditions 
or modes.

Size Grip

Click and drag to resize 
the horizontal and vertical 
dimensions of the window.

Figure 3.4

DynaComm Connectivity Series 9 Window.

Window Elements

The DCS 9 application window presents standard interface 
tools that you may have used with other Windows applica-
tions. Figure 3.4 identifies common elements of the DCS 9 
application window.
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Toolbar

The standard DCS 9 toolbar provides 13 quick-access but-
tons for frequently used functions. Each button has a menu 
equivalent.

Table 3.1

Toolbar quick-access buttons.

 Tool Tooltip Description

  New Starts New Session wizard or opens last document type 
opened

  Open Displays File Open dialog

  Save Saves active session properties

  Cut Places copy of highlighted text on clipboard and removes 
text from the display

  Copy Places copy of highlighted text on clipboard

  Paste Places copy of clipboard contents in display at cursor 
position

  Session Properties Displays Session Properties dialog for the active session

  Connect/Disconnect Toggles active session connection status with host speci-
fied in session properties

  Send File Displays Send File dialog to start transfer of file from 
local system to remote host (upload)

  Receive File Displays Receive File dialog to start transfer of file from 
a remote host to local system (download)

  Print Prints contents of active window

  About Displays About DynaComm dialog

  What’s This Activates What’s This? help feature
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Lesson 4:  Working with a Session

This fourth lesson

6 Outlines steps to create a session.

6 Reviews changing session properties.

6 Saves a session and opens a saved session.

6 Works with multiple session windows.

Creating a Terminal Session

A terminal session includes, at a minimum:

6 An Emulator

6 A Connector

A file transfer protocol can be selected but is not required.

By default the New Session Wizard is enabled when DCS 
9 is installed. The New Session Wizard guides you through 
the process of selecting the minimum requirements for 
creating a session.

The New Session Wizard is disabled by clearing the Use 

‘New Session’ Wizard option on the General tab of the Op-

tions dialog (Tools > Options).

If the New Session Wizard is disabled or no selections are 
made, DCS 9 automatically includes the following session 
properties:

6 ANSI-BBS emulation

6 Telnet connector

6 ZModem file transfer protocol

Session properties are changed through the Session Proper-

ties dialog.

Note: Default session properties may be changed by 
your system administrator.

The following steps to create a terminal session use the New 
Session Wizard. If the wizard is disabled, continue to step 5 
after completing step 1.

Step 1: Access the New Session Command

6 To create a new session, do one of the following

• Click the New Session toolbar button.

• On the File menu, highlight New and click Ses-

sion.

The New Session wizard starts and displays the New Ses-

sion Wizard - Emulator Type dialog appears (see Figure 3.6).

Figure 3.5

General tab of Options dialog.
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Figure 3.6

New Session Wizard - 

Emulator Type dialog.

Figure 3.7

New Session Wizard - 

Connector Type dialog.

To respond to this dialog

• Select an emulation and click Next.

The New Session Wizard - Connector Type dialog appears.

Step 3: Select a Connector

The New Session Wizard - Connector Type dialog lists all 
installed connectors.

To respond to this dialog

• Select a connector and click Next.

The New Session Wizard - File Transfer Type dialog ap-
pears.

Step 2: Select an Emulation

The New Session Wizard - Emulator Type dialog lists all 
installed emulations.
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Step 4: Select a File Transfer Protocol

The New Session Wizard - File Transfer Type dialog lists all 
installed file transfer protocols except for FutureSoft FTP. 

Figure 3.8

New Session Wizard - 

File Transfer Type dialog.

This protocol is provided as a standalone FTP utility which 
can be started from the DCS 9 window with the Tools > 

FTP command or on its own, as described at the end of 
Lesson 5.

To select a file transfer protocol

• Select a file transfer protocol and click Finish.

The Session Properties dialog appears.

Step 5: Make Session Property Changes

The Session Properties dialog appears each time a new ses-
sion is created. The Connectors tab is displayed.

To complete session configuration, you must specify a:

6 Network host, if Telnet connection is used.

6 Serial communication port, if direct serial connection 
is used.

6 Phone number, if modem connection is used.

To respond to this dialog

1 Supply the required corresponding connection infor-
mation.

2 Click OK.

The connection is made and a session window opens.

Figure 3.9

Connectors tab of the Ses-

sion Properties dialog.
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Step 6: Saving the Session

The configured session properties are valid only for the cur-
rent instance of the session. To retain the configured session 
properties, you must save the session.

To save a session with the default session file name

1 On the File menu, click Save or Save As.

The default session file name appears in File Name in 
the Save As dialog.

2 Click Save.

To save a session with a custom session file name

1 On the File menu, click Save As.

The default session file name appears in File Name in 
the Save As dialog.

2 In File Name, enter a new file name and click Save.

Step 7: Opening a Saved Session

Saved session files are stored in the Session folder.

To open a saved session

1 On the toolbar, click Open.

2 Select a session file and click Open.

Working with Multiple Windows

DCS 9 is designed with a Windows Multiple Document 
Interface (MDI). Multiple session files, scripts, or memo 
documents can be open in a single instance of DCS 9.

Use the Windows menu to view a list of all open windows. 
A check mark appears next to the active window. Click a 
window in the list to make it the active window. Multiple 
windows can be arranged to fit the application workspace.

To arrange multiple windows

1 On the application menu bar, select Windows.

2 On the Window menu, select the desired windows 
arrangement.

• Cascade arranges the windows in an overlapping 
stack of equal sized windows such that the title 
bar of each window is visible.

• Tile Horizontally arranges the windows in equal 
horizontal widths that fill the application window.

• Tile Vertically arranges the windows in equal 
vertical widths that fill the application window.
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Lesson 5:  Transferring Files

This fifth lesson :

6 Reviews selecting a file transfer protocol.

6 Outlines steps to send files (upload) to a host.

6 Outlines steps to receive files (download) from a host.

6 Describes the FutureSoft FTP utility.

File Transfer Protocols

When creating a new session, only installed file transfer 
protocols appear in the Session Properties dialog. The file 
transfer protocol can be changed at any time. However, 
changing protocols automatically disconnects and then 
re-connects the session to the host. Therefore, to ensure data 
transfer integrity, do not change the protocol during a file 
transfer. Stop the current transfer first, change the protocol, 
and then reinitiate the transfer.

To select or change a file transfer protocol

1 On the Session menu, select Properties.

2 In the Session Properties dialog, click the File Trans-

fers tab.

3 Select a file transfer protocol button.

4 Click OK to close the Session Properties dialog.

Sending Files (Upload)

After a connection to a host has been established, the Send 

File and Receive File commands are enabled. DCS 9 can 
transfer files to any host that supports the configured trans-
fer protocol. To transfer a file to a host, the host system or 
application must be readied to receive a file.

 Note: Within DCS 9, the configuration requirements 
for sending a file to a host will vary by host, host 
application, and the file transfer protocol. e de-
fault file transfer protocol settings can be changed 
to suit your particular host or host application.

To send a file to a host

1 Configure the host or host application to receive a 
file.

2 On the toolbar, click Send File.

3 In the Send File dialog, specify the file(s) to transfer.

If changes to the file transfer protocol configuration 
are needed for this transfer only, click Setup and 
make the changes in the Session Properties dialog.

4 Click OK to start the transfer.

The File Transfer Status dialog appears to show the 
progress of the file transfer.
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Receiving Files (Download)

After a connection to a host has been established, the 
Receive File command is enabled. To receive a file, the host 
system or application must be readied to send a file. Check 
with your system administrator or consult the host applica-
tion documentation if you need assistance configuring the 
host to send a file.

Note: Within DCS 9, the configuration requirements 
for sending a file to a host will vary by host, host 
application, and the file transfer protocol. e de-
fault file transfer protocol settings can be changed 
to suit your particular host or host application.

To receive a file from a host

1 Configure the host or host application to send a 
file(s).

 Note: By default, when a host sends a Receive 
command to start a file transfer, ZModem 
autostarts. is option may be turned off. See 
the Online Reference for more information.

 If ZModem autostarts the transfer, the file 
name is sent in the first packet.

2 On the toolbar, click Receive File.

3 In the Receive File dialog, specify the file(s) to trans-
fer.

If changes to the file transfer protocol configuration 
are needed for this transfer only, click Setup and 
make the changes in the Session Properties dialog.

4 Click OK to start the transfer.

The File Transfer Status dialog appears to show the 
progress of the file transfer.

FSFTP utility

DCS 9 ships with a standalone File Transfer Protocol 
(FSFTP) utility. The FSFTP utility supports file transfers 
to and from a host using the FTP protocol over a TCP/IP 
connection.

FSFTP installs in the installation directory of DCS 9. The 
DynaComm Connectivity Series 9 program group provides 
a shortcut to start FSFTP outside of DCS 9. If you have 
started DCS 9, access FSFTP with the Tools > FTP com-
mand.

An Online Reference (Help system) for FSFTP is provided 
with the utility.
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Lesson 6:  Printing

DCS 9 offers a range of local printing options, including:

6 Printing the current screen

6 Printing a selected area

6 Printing the entire contents of a session

6 Allowing the host system to send raw data directly to 
your local printer

6 Printing using a specific font, and adding header and 
footer information to each page

Before printing, a printer must be installed and configured. 
The printer can be a local or network resource.

Printer configuration

Although you must install local printer drivers using the 
Windows Add/Remove Hardware wizard, you have the 
option of configuring an installed printer without closing  
DCS 9.

6 To configure a printer

1 On the File menu, select Print Setup.

2 In the Print Setup dialog, select a printer.

3 Click Properties and configure the printer as 
needed.

 Note: Changes to printer properties are tempo-
rary and affect only the current print job. 
ey are not saved with the session, script, 
or memo file and have no effect on print 
jobs for other windows or applications.

4 Do one of the following:

• Click OK to accept the print setup

• Click Cancel to discard changes.

Note: Local printing options do not affect out-
put printed to a host or remote system.

Print Setup Options (Session Only)

For individual print jobs, a specific printer, font, and header 
and footer elements can be specified using the Print Setup 
dialog. The File > Print Setup command displays this 
dialog. Print setup for memo and scripts use the Windows 
Print Setup dialog.

Figure 3.10

Print Setup dialog.

6 To configure an individual print job

1 On the File menu, select Print Setup.

2 In the Print Setup dialog, select a printer.

3 Select a font.

4 Use the default settings for Raw Passthrough 

Mode. If you wish to use a different setting, see 
the Online Reference for more information.

5 Select the right arrow buttons next to the Header 
and Footer fields to add information at the top 
and bottom, respectively, of each printed page.

6 Click OK to accept the print job configuration, or 
click Cancel to discard any changes.

Note: Local printing options do not affect print 
output to a host or remote system.
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Print Preview

Before sending a job to a printer, print results can be viewed 
online. Options include viewing pages either side-by-side or 
one at a time, in two levels of magnification.

6 To preview a print job

1 Display the item to be printed in the active win-
dow by selecting the corresponding window title 
from the Window menu.

Window title is the name of the session, script, or 
memo to be printed.

2 On the File menu, select Print Preview.

The Print Viewer window replaces the session, 
script, or memo window. By default the Print 
Viewer displays one page at a time for multiple 
page previews.

3 Select the functions on the Print Viewer toolbar 
as needed.

Tip: Each window provides its own print preview. 
erefore, two or more print previews can 
be compared side-by-side by selecting a til-
ing option from the Window menu.

Use This Button  To . . .

 Sends the job to the printer and closes 
the Print Viewer window.

 Displays the succeeding page in a mul-
tiple page print preview.

 Displays the prior page in a multiple 
page print preview.

 Creates a simple print view display of 
two consecutive pages.

 Enlarges the page size in the print 
Viewer window.

 Reduces the page size in the Print 
Viewer window.

 Closes the Print Viewer.

Table 3.2

Print Viewer functions.
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Printing a Session Window, Script or Memo 
Document

The Print dialog is used to make changes to a print job.

6 To print from an open session window

1 Display the item to print in the active window by 
selecting the corresponding window title from the 
Window menu.

Window title is the name of the session, script, or 
memo to be printed.

2 On the File menu, select Print.

The Print dialog appears.

Note: Open sessions that have not been con-
figured or have not attempted a connec-
tion appear as an empty window. ese 
windows cannot be printed.

3 Select a print option.

4 Click OK.

Figure 3.11

Print dialog.

Printing to a File

Print output can redirected to a file. The contents of the 
file is raw print data that can be viewed with any text editor 
(such as NotePad). However, to print the file in a format 
other than raw data, it must be sent to a printer that uses a 
Printer Control Language (PCL) print driver.

6 To send the file to a printer for output

1 Enter the following at a DOS command prompt

copy  filename.ext  LPTx  /B

where:

filename is the fully qualified path and name of 
the file (such as c:\sales\june99.prn)

.ext is the file extension (usually .prn)

x is the LPT port number (such as LPT1)

/B indicates that the file is a binary file

2 Press Enter.
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Removing All Components

The uninstall utility removes only those items installed by 
the Setup program. It does not remove session files, scripts, 
memo documents, custom keyboard maps, or any other file  
not installed by Setup. Also, it does not remove an installed 
file that has been renamed. Removing the base DCS 9 
program also removes all Client Options.

Step 1:  Start the Setup Program

Start the Setup Program using one of the techniques dis-
cussed in Chapter 2 Setup Program. 

Chapter 4
Removing DCS 9

Step 2:  Respond to Setup Dialogs

Setup Dialog 1:  Welcome

The Welcome dialog appears when the Setup Program 
has  completed loading.

To respond to this dialog

• Click Next.

Setup Dialog 2:  Program Maintenance

The Program Maintenance dialog offers three options. 
The Remove option removes all program components, 
including Client Options, of DCS 9.

To respond to this dialog

• Select Remove.

• Click Next to start the removal.

Setup Dialog 3:  Remove The Program

The Remove the Program dialog appears to confirm the 
removal.  

• Click Remove to start the removal.

Setup Dialog 4:  Maintenance Complete

The Maintenance Complete dialog appears when the 
removal is complete. 

To respond to this dialog

• Click Finish to close the Setup Program.
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Removing Selected Components

The Setup program can remove selected components and/or 
sub-components of DCS 9. When the Custom Setup dialog 
appears, all installed components are listed.

Step 1:  Start the Setup Program

Start the Setup Program using one of the techniques dis-
cussed in Chapter 2 Setup Program.

Step 2: Respond to Setup Dialogs

Setup Dialog 1: Welcome

The Welcome dialog appears when the Setup Program has  
completed loading.

To respond to this dialog

• Click Next.

Setup Dialog 2:  Program Maintenance

The Modify option allows for removal of selected program 
components.

To respond to this dialog

• Select Modify.

• Click Next to start the removal.

Setup Dialog 3: Custom Setup 

6 To remove a component, 

1 Select the item. 

2 On the pop-up menu, select “is feature will not 
be available”.

3 Choose one of the following

• Back to return to the Select Setup Type 
dialog.

• Next to continue with the removal.

• Cancel to exit Setup.

Setup Dialog 4:  Ready to Modify the Program

The Ready to Modify the Program dialog appears to con-
firm the removal.  

• Click Install to start the removal.

Setup Complete

The InstallShield Wizard Completed dialog appears when 
the removal is complete. 

To respond to this dialog

• Click Finish to close the Setup Program.
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A

About command  26
administrator  10
ANSI-BBS emulation  6, 27
AT&T 4425 Client Option  6
AT&T 6539 emulation  7
attribute map files  23
Autorun, CD  14
autostart  32

B

backups  13
base product  6
browser  20

C

CD Autorun  14
Client Options

AT&T 4425  7
HP 700/94  8
Tandem 6530  8
TN3270  9
TN5250  9

command line  10, 20
components

removing  37
configuration, printer  33
connectors

AT&T 4425  7
base product  6
default  27
direct serial  6, 7, 8, 29
HP 700/94  8
installed  28
modem  7, 8, 29
Tandem 6530  8
Telnet  8, 27, 29
TN3270  6

Connect command  26
contact  12–13, 13
Control Panel, Windows  14
Copy command  26
corrections, install  15
Custom setup type  17
Cut command  26

D

date calculation  6
DCS 8

base product  6
Client Options, add-on  7–9
files and folders  21
installing  15–21
removing  37–38, 37–40
starting  20–21

DEC. See Digital VT Series emulation
dialogs

Maintenance Complete  37
New Session Wizard, Connector Type  28
New Session Wizard, Emulator Type  28
New Session Wizard, File Transfer Type  29
Options, File Locations tab  22
Options, General tab  27
Print  35
Print Setup  33
Select Components  38
Select Setup Type  16
Session Properties, Connectors tab  29
Setup Complete  38
Setup Maintenance  37
Software License Agreement  16
User Information  16
Welcome  15
Welcome (Setup Maintenance)  38

Digital VT Series emulation  6
direct serial connector  6, 7, 8
Disconnect command  26
display files  21

Index
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documentation library  10
documents

memo  23
script  23
session  23

download files  21, 26, 32

E

e-mail  12, 16
eBooks  10–12
editor  6
EHLLAPI  6
EM3270 support  8
emulations

add-on  6
ANSI-BBS  27
base product  6
default  27
HP 700/92  8
installed  28
Tandem 6530  8
TN3270  9
TN5250  9

errors, installation  18
euro symbol  6
evaluation version  18
extensions, file types  23

F

files  21
Attribute Map  23
connector  23
copying  15
display  21
emulation  23
file transfer  21, 23
font  21
Keyboard Map  23
opening  24
Readme  10, 11, 20
receiving (download)  32
sending (upload)  21, 31
session  21
Trace Facility  23
transferring  21, 26, 31–32

file transfer  18

file transfer protocols
default  27
installed  29, 31–32

file transfer protocols, supported
AT&T 4425  7
base product  6
HP 700/94  8
Tandem 6530  6, 8
TN3270  6, 9
TN5250  9

file types  23
file version  10
folders  21
font

files  21
used in printing  33

FSFTP utility  20
FTP protocol  7, 8

H

help, finding & using  11
HLLAPI Auto-Launch Configurator utility  10
HLLAPI Interface  9
host application  31, 32
hotspot support  8, 9
HP 700/94 Client Option  6, 8

I

icon  20
IND$FILE protocol  6, 9
installation  13–18

single user  15–22
steps  14
troubleshooting  18

install requirements  7
IXF protocol  6

K

Kermit protocol  7, 8
Keyboard Map files  23

L

licensed copy  18
Licenser utility  18, 20
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M

Maintenance Complete dialog  37
media, installation  13
Meridian LAT32 connector  6
Microsoft SNA Server connector  6
Modem connector  6, 7, 8
Multiple Document Interface (MDI), Windows  30

N

New command  26
New Session Wizard  27–30

Connector Type dialog  28
Emulator Type dialog  28
File Transfer Type dialog  29

NotePad, Windows  35

O

OLE  6
Online Reference(s)  10–11, 20
Open command  26
Options dialog

File Locations tab  22
General tab  27

P

Paste command  26
printer configuration  33
printing  26, 33–35

to a file  35
Print command  26
Print dialog  35
Print Setup dialog  33
Print Viewer  34
program group  18
program group, DCS 8  20
properties, session  31–32
protocols, file transfer  7, 8, 27

R

Raw Passthrough Mode  33
Readme file  10, 11, 20
Receive File command  26
registration  20

card  10, 13
Release Notes  10, 11, 20
requirements, system  13

S

Save command  26
script(s)

compiling  23
documents  23, 24
files  23, 24
starting  24

scripting language  6, 10, 20
Select Components dialog  38
Select Setup Type dialog  16
Send File command  26
serial number  13, 18
session

connection status  26
creating  27–30
files  21
open  30, 35
printing  33
properties  26, 27, 29, 31–32
saving  30

Session Properties command  26
Session Properties dialog  29
Setup Complete dialog  38
Setup Program  14–16, 15, 37, 38
SNA Server (Microsoft) connector  6
Software License Agreement dialog  16
soft fonts  8
space available  17
space required  17
Standard Install  11
support, technical  12
system requirements  13
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T

Tandem 6530 Client Option  6, 8
Technical Support  12
TeleVideo 925/950 emulation  6
Telnet connector  6, 7, 8, 27
TN3270 Client Option  6, 9
TN5250 Client Option  6, 9
toolbars  25, 26, 34
Trace Facility files  23
transferring files  26
troubleshooting  18
tutorial  19–42

U

upgrading  11, 13
upload files  21, 26, 31
User Information dialog  16–20
utilities

FSFTP  20
Licenser  18, 20

V

version
documentation  10
file  10
product  12, 13, 18

Visual Basic Interface  20

W

Web Install  11
web site  10, 20, ii
Welcome (Setup Maintenance) dialog  37, 38
Welcome dialog  15
What’s This command  26
window

active  30
DCS 8  25
empty  35
multiple  30
Print Viewer  34
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